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1 Introduction This Quick-Guide is intended to accompany an instructor or colleague-led overview of Smart View. Ideally, those new to Smart view or Essbase will be paired up with someone who has worked with the tool before, or with an instructor. This guide is also intended as a reference.  
1.1 What is Essbase? 
Oracle Hyperion Essbase is a multidimensional database optimized for planning, analysis, and management reporting applications. Essbase combines the advanced functions of Microsoft Excel with sophisticated ad hoc reporting capabilities.   Essbase databases store one kind of data:   NUMBERS  There is no formatting of the numbers inside of Essbase; all formatting (e.g. currency-2 decimals; percentage; integer, etc.) occurs on front-end tools such as MS Excel.   From an end-user’s perspective, the biggest difference in a reporting and/or budgeting system based solely on Excel Spreadsheets and a system based on Essbase, is that the source data is stored centrally in Essbase versus separately on several (or several hundred) spreadsheets.  This centralization of source data has two advantages:  Data cannot be duplicated inside of Essbase: There is only 1 source (version) of the data. Even if multiple copies of the data exist in spreadsheets or linked workbooks, there will only be a single source of the data.  There is no need to assemble data from multiple outside sources and combine them into spreadsheets. Data is typically refreshed nightly, weekly, or monthly.   Essbase is called a multidimensional database because data is stored in terms of dimensions, actually, in terms of multiple dimensions.   What does this mean? Simply, that all of the data that traditionally might be gathered from multiple data sources and assembled in Excel will now be stored centrally in a database and made accessible (and updateable) through MS Excel and/or pre-defined Excel templates 
1.2 Background 
Tutor Perini uses a combination of pre-defined Templates and Smart View Ad-Hoc spreadsheets for reporting and analysis.   
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1.2.1 Multidimensional Database: What is it? 
As scary as it might sound, a multidimensional database is really just a fancier, more functional spreadsheet (it is a bit more, but it is useful to ground the term in something analysts and users are familiar with).   Most people new to Essbase are already familiar with the way Essbase organizes data, because analysts have been assembling and reporting data within Excel using the perspectives or dimensions required in reporting.   

   Look at the following Excel report which could have come from any organization:  

  In the preceding screenshot, data is represented in terms of the following 4 Perspectives: 1. Accounts (in the rows: Row5=Current Assets, Row6=Total PP&E, etc.) 2. Time (in the columns: ColB=Beginning Balance, ColC=Jan, etc.) 3. Scenario (Actual, not Plan or Forecast data) for the whole report; think of this as a header or page perspective. 4. Year (Y2007, not Y2011, or Y1998, etc.) Data for the whole report. 

TIP: 
 Think of Dimensions as Perspectives of your business…the “by” and “for” designations in a report.  
A report BY Account FOR Jan, Feb, Mar FOR Actual and Plan 
BY Fiscal Year. 
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1.2.2 A Database that Extends into Excel 
EssBase is short for Extended SpreadSheet DataBASE. This is an 
appropriate name for what Essbase does: It extends the Spreadsheet into a database.  For most users new to working with Essbase there are some important differences between working exclusively with spreadsheets and working with spreadsheets and Essbase:  The data no longer lives in spreadsheets – The data source becomes Essbase, and the mechanism through which data is viewed, presented and reported is Excel.  All Excel functionality is present, in addition to being able to access data directly in Essbase.  In order to get the latest data, users need only refresh or retrieve data into an Excel report.  
1.2.3 Essbase data in Excel 
When retrieving or refreshing data from Essbase inside of a workbook, there are two areas that Essbase uses in order to deliver the data:   Dimensional information – think of these as the labels that give the data context (e.g. the label “Jul” lets Essbase [and the user] know that the data in Column “C” is October data) Essbase requires a complete set of these labels in order to know where to put the data in the data area. 

 Data area – This is where the data or numbers are presented back to the user.   

 
1.2.4 Essbase Database - Projects 
The Essbase database created on reporting projects related data is called Projects. This database has the following dimensions.  
Dimensions Description 
Account Contains the accounts like Earned Revenue, Actual 

2014 01031 - TPC Civil - East JDE Actual YTD Project Status Jul
Earned Revenue Actual Revenue Overbilled Underbilled

               10022100 - 500 West Hudson Yard (339,849)                  -                                         -                (279,352)       
               10182000 - Amtrak Tunnel (54,652,399)            (59,063,203)                        4,410,804    -                  
               10022000 - CQ32 - Plaza Substat (40,216,402)            (43,472,640)                        3,256,238    -                  
               10274800 - CS179 System Facilities P (8,863,641)               -                                         -                (8,863,641)    
               10167000 - ERY Passage of the Highli (30,777)                     (39,504)                                 8,726            -                  
               10101200 - FLL  Runway 9R-27L (35,227,231)            (34,437,152)                        -                (790,079)       
               10200700 - FLL - Terminal 4 Apron Ex (2,171,729)               (3,562,247)                           1,390,518    -                  

Dimension Information 
(Metadata) 

Data: The Numbers! 
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Revenue, Overbilled, Underbilled and so on. 
Periods Months (e.g. January, February etc.) Quarters, Year 
TimeView MTD,QTD,YTD,ITD 
Years FY11, FY12……FY20,NoYear 
Scenario JDE Actual, Topside Adjustments 
Entity 01031, 01051, External and Internal Entity reporting hierarchy 
Projects Contains the project codes  
Project Status Contains labels (new and existing) to classify data based on the project status 
State Attribute dimension to report project related data based on the location defined by the State, e.g. CA, AL,AZ 
End Market Attribute dimension to report project related data based on the project’s end market e.g. AIR, BRI 
Contract Type Attribute dimension to report project related data based on the project’s contract type e.g. CP (Cost Plus), FP (Fixed Price) 
Client Source Attribute dimension to report project related data based on the project’s client source e.g. FE (Federal), PV (Private) 
Job Stage Attribute dimension to report project related data based on the project’s job stage e.g. CLD (Closed), OPN (Open) 
ICP Attribute dimension to report project related data based on the project’s intercompany tagging e.g ICP-Y (Intercompany project), ICP-N (Not an intercompany project) 
Job Type Attribute dimension to report project related data based on the project’s job type e.g. JA (Job Cost Administrative), JB (Job Cost) 
Ownership Type Attribute dimension to report project related data based on the project’s ownership type e.g. JVN (Joint Venture Non-Sponsored), WO (Wholly Owned) 
Insurance Type Attribute dimension to report project related data based on the project’s insurance type e.g. CAL, SEL 
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2 Hyperion SmartView Excel gives users an easy and familiar interface into Essbase.  With Smart view, users can:   Quickly assemble reports in an Smart view Ad-hoc fashion  Refresh data in existing Excel reports or templates in a few mouse clicks  Open web form in Smart view connecting to Planning  Everything a user needs in order to interact with the data in Essbase comes from Smart view.  Once Smart view has been installed, the Hyperion Smart View menu bar appears alongside other Excel menu items.  Once the user connects to Essbase database Smart View adds an additional tab called ‘Essbase.    

  At first glance, the menu options seem daunting, but with an investment of as little as 30 minutes, and follow-up exercises, most users find themselves quickly leveraging the power of Essbase.  In addition to the capabilities provided by the smart view, none of the Excel functionality is lost. It is the ideal tool for those analysts who live, eat, and breathe Excel and spreadsheets.  
2.1 Connecting to Essbase 
 
Go to Smart View->Options  

  Below panel will open:    
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  Click on the “Advanced” tab, Enter the environment URL to connect. Here’s the Hyperion Production environment URL for Tutor Perini.   Production URL: http://hy-pweb01.tutorperini.com/workspace/SmartViewProviders    Then click OK.  Then, click on SmartView->Panel. Then Click on ‘Shared Connections’  
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  Enter your username and password to connect to smart view. The user name and password will be the same as your Windows logon. Click Connect   

    The connection panel will open on the right.   

  
Then from the dropdown select ‘Oracle® Essbase’.  Expand EssbaseCluster-1, then expand Projects and then click on Projects and then click Connect   
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  Once you click on connect, you will see an ‘Ad hoc analysis’ option. Click on Ad-hoc analysis.    

  The excel sheet will refresh and display the dimensions in Excel.  
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2.1.1 Connecting additional worksheets to Essbase 
 
Once you connect to Essbase from a worksheet, the connection is limited to that worksheet only. If you want to connect another worksheet, you need to explicitly connect to it, though you do not need to enter the user-id/password again.  Say, you are connected to Essbase from a worksheet and you want to use another worksheet to retrieve data from Essbase:  Select the tab (worksheet) you want to connect to: From the connection panel on the right, click on Adhoc Analysis   

  If it is a new worksheet, the worksheet will refresh and will add Essbase dimensions to the worksheet.  If the worksheet was used in a prior smartview operation, you will receive a prompt as shown below:  
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  Click on ‘Reuse sheet contents and POV’. This will connect and refresh the worksheet with the existing layout of the Essbase members.  
2.1.2 Viewing Essbase Connections 
In order to see which Excel workbooks/worksheets are connected to Essbase 
select Smart View | Sheet Info. This will show you sheet info. It includes 
Server, Application, Database, URL, Provider, Provider Version, Alias table, Sheet Type, Connected or not.   
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2.1.3 Multiple Instances of Excel - YES! 
You can connect multiple instances of Excel using Smart View.  
2.2 Getting Started: 2 Modes 
Any time an analyst sits down to work with data in Essbase they are interested in one of two types of reporting:   Ad-Hoc analysis – starting with a blank workbook and drilling into details from upper levels (e.g. starting at the Total Vendors and drilling into specific Vendor for Specific accounts, and reorienting the data as the analyst iterates through the data sets. This is a very fluid type of analysis, and Essbase is ideally suited to this. 

 Refreshing data in an Excel Report or Template - This is a static kind of analysis. This usually entails opening up an existing work book, and simply retrieving the data from Essbase. 
 In each case, there are certain Essbase Options that are better suited to Ad-Hoc analysis versus Refreshing data in a report.  
2.2.1 Ad-Hoc Analysis SmartView Option Settings 
These are recommended settings from the SmartView Options menu. As you grow more comfortable with Smartview, you may deviate and find your own preferences.  The settings shown here imply the need to be totally flexible in the analysis (ad-hoc) of data. These settings will not impose limitations on pivoting data; they will also provide immediate visual feedback when querying data.  This section summarizes the recommended settings. A later section explains in detail all of these options  
From the Smart View | Options selection:  
 

  [Member Options] Tab  Zoom In Level Next level 
 Member Name Display Member Name and Alias 
 Indentation Totals 
 Member Retention  Include Selection  
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 [Data options] Tab  Suppress Rows (nothing checked)  Suppress Columns (nothing checked)  Replacement – #NoData/Missing Label (user preference) #NoAccess Label (#NoAccess) #Invalid/Meaningless (#Invalid)    [Advanced] Tab  Number of Undo Actions (user preference)  
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  [Formatting] Tab   Use Cell Styles (user preference)  Use Excel Formatting (user preference)  Adjust Column width (checked this option)  
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  [Cell Styles] Tab: NOTE: If the [Analytic Services] option is missing from the Cell Styles tab, this means that the worksheet is NOT connected to Essbase.  Connect sheet to Essbase, this will bring the [Analytic Services] option into the Cell Styles tab. 
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  To use different cell style tab options, click on Cell Styles under Formatting tab.  Go to Analytic Services-> Member cells  Parent (checked), go to Properties->Font, Background, Border and update the user preferences.  
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  NOTE: There are many Formatting options available, and in some cases it is worth experimenting with these styles. Most of the time, however, this is the only style (Parent) that users select.   When doing ad-hoc analysis this gives users immediate visual feedback in terms of whether or not there is more detail (children of members) in a report.  

  
 

 
2.2.2 Refreshing an existing excel report/template.  
The settings shown here imply the need to preserve the layout, formatting and formulas in an existing report. There is no need to zoom into detail or pivot.   
From the Smart View | Options selection:  

2014 JDE Actual YTD Project Status Jul
Earned Revenue Actual Revenue Overbilled Underbilled

     01021 - TPC Civil - Metro Total Projects -5914339.34 205.8 0 -5914545.14
     01031 - TPC Civil - East Total Projects -313773524.9 -346238759.4 78664036.31 -46107002.29
     02701 - Cherry Hill Construction  Inc. Total Projects -47117138.11 -50732572.36 10121336.33 -6505902.08
Tutor Perini Civil East Total Projects -366805002.3 -396971126 88785372.64 -58527449.51

Bottom-level members are not bold, 
indicating no detail below 

Parent Members are BOLD, indicating there 
are ‘children’ or ‘descendants’ details that 
can be drilled/zoomed into. 
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    [Data Options] Tab  Suppress row/column (nothing checked)  Replacement:  #NoData/Missing Label - “-“, “0”, a space or #NumericZero #NoAccess Label - #No Access 

   [Formatting] Tab  Use Cell Styles (user preference) 
 Use Excel Formatting (user preference) 
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 Adjust Column width (user preference) 

  [Cell Style] Tab  
The settings on the [Cell Style] tab become irrelevant if Use Cell Styles is 
disabled from the [Formatting] tab. When retrieving into existing reports or templates, there are usually excel formats applied (underline, bold, borders, 
shading, etc.); these formats will be cleared out (not desirable) if Use Styles 
is turned on.  
2.3 Essbase Naming Conventions 
There are a few naming conventions and ways to reference data in Essbase that are important to understand.  
2.3.1 Dimension and Member names 
In all Essbase Databases there is a practical limit to the number of dimensions (usually between 5 and 15). The dimensions contain individual members. Members are everything below the Dimension level.  
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  Example: 
DIMENSION Example Members in the dimension 
Account Actual Revenue, Earned Revenue, Underbilled 
Periods Jan, Feb, Mar, Quarter1, Quarter2… etc. 
Entity 01031, Total Civil West 
Years FY11, FY12, etc. 
 When viewing data it is important to get in the habit of thinking about members or member names.  For example:   ‘Earned Revenue’ is a member of the Account dimension  FY11 is a member of the Years dimension  01031 is a member of the Entity dimension  
2.3.1.1 Member Names and Aliases 
All databases will employ aliases as well as member names.  The member name is typically a short name (e.g. 01501) where the alias is a longer (descriptive) name, usually incorporating some part of the member name (e.g. “01501 - Black Construction Investments Inc.”).  
Member Name Alias 
01501 01501 - Black Construction Investments  Inc. 
01511 01511 - Tutor Pacific 
01521 01521 - Tutor Pacific Construction 
01531 01531 - Black Construction Corporation 
01541 01541 - Tutor Micronesia Construction LLC 
 

TIP: 
 Think of members as: “Family Members of Dimension x”.  Example: “Jan” is a (family) member of the Periods dimension.  “Actual Revenue” is a (family) member of the Account dimension  Member “Jan” is a child of Member “Quarter 01” in the Periods dimension 
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2.3.2 Generations and Levels 
When referring to member names within a Dimension hierarchy there are a number of ways to reference them.   Generation References are considered Top Down references since they refer to members from the top and increase as you drill into detail. Generation References are also considered ABSOLUTE references. This means that the Generation does not change for a member. 

 Level References are considered Bottom Up references since they refer to members starting from the bottom level (level 0) and work their way up the hierarchy.  
2.3.2.1 IMPORTANT: Level 0 
Level 0 members are unique. This is where data is loaded into Essbase, it is also the end-point of analysis in many cases. A user starts out at the top of a dimension and drills into the detail and ultimately arrives at the bottom (Level 0).  There are a number of synonyms for “Level 0” that analysts and those familiar with Essbase use interchangeably:   Level 0 

 Bottom Level 
 Leaf Level 
 Input Level 

2.3.3 Parents, Children, Ancestors and Descendants 
Another way of referring to (Dimension Family) Members in Essbase is by using Genealogical References.  For example:  Drill into the Children of Vendor – C. 

 Show all the Descendants of Department Global Sales 
 Show the Ancestors of January (January, Q1, YearTotal) 

 There are a number of settings in Smart view that provide the flexibility of retrieving members based on DESCENDANTS, CHILDREN, LEVELS, etc.  
2.4 Retrieving into a blank Excel sheet 
From the menu bar select Essbase | Refresh.  
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  This is also called a top-level retrieve. This retrieve brings the Dimensions into the spreadsheet.  The order or layout will always be the same for each database:   Cell A3 = Dimension 1 = Accounts  Cell B2 = Dimension 2 = Period  Cell B1 = Dimension 3 = Year  Cell C1 = Dimension 4 = Entity  Cell D1 = Dimension 5 = Scenario  Cell E1 = Dimension 6 = Time View  Cell F1 = Dimension 7 = Projects  Cell G1 = Dimension 8 = Project Status  The 1st dimension is usually the Accounts or Measures dimension since: 
 Users most commonly start drilling into ACCOUNT/MEASURES Detail.  Account Detail is typically displayed in the ROWS 

Please note that attribute dimensions are not displayed when a refresh is done. Attribute dimensions need to be explicitly selected and refreshed. 
2.4.1 Know your Dimensions 
In order to become a slice and dice pro, it is critical that you know the dimensions you are working with, and, at-a-glance, can name the members on a worksheet and which dimensions they belong to.  Take a moment to fill in the blanks below with the DIMENSION Names and some example Member names.  Hint – on your Top Level Retrieve, select, select any dimension and then click 
Essbase | Member Selection to browse the dimensions for some of the 
member names.   
DIMENSION Example Member Names 
1.)  
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2.)  

3.)  

4.)  

5.)  

6.)  

7.)  

8.)  

 
2.4.2 Top Level Retrieve: what next? 
Any time an analysis starts with a Top-Level retrieve there are some standard actions you want to do:  

    Format the data – Remember, Essbase does not store formatted numbers. Most of the time the easiest thing to do is to highlight the whole workbook and select the desired Excel number format (e.g. “Comma Style”, no decimals).  
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   Identify the members for certain dimensions – In most cases there is a specific destination in mind for the analysis. For example, Analyze data for 
o TOTAL ACTUAL (not Forecast or Budget) 
o For the current Fiscal Year i.e. FY14 
o For a specific entity E.G. 01031 
o For All PROJECTS 
o For JUL  By changing the default Dimension names to one of the relevant (e.g. ACTUAL) member names for the retrieval, the Top Level retrieval immediately becomes more than just a top-level retrieve.  There are 2 ways to identify the members: 
 Type in the member name (if you know it…member names MUST be typed in exactly as they exist in Essbase) 
 Use the Member Select Feature. 

 By identifying the members from 4 of the 8 dimensions, the analysis becomes a lot less complicated, instead of having to drill in to detail on all 8 dimensions  
2.5 Essbase Data Layout in Excel 
When working with data from Essbase there are 3 orientations that Essbase uses to lay out the data:   Page (or sometimes Header) – These are restricted to a SINGLE (family) member from a dimension or just the Dimension itself. 

 Column – These are the column labels. There can be one or more Column-oriented members from one or more dimensions 
 Row – These are the row labels. There must be AT LEAST 1 row-oriented dimension in the layout. That is why the top level retrieve always brings the first dimension down to cell A2. 
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   It is not critical that you memorize “Page”, “Column”, and “Row” orientation. Essbase will take care of orienting the members as you zoom in, pivot and keep members.   
2.5.1 Layout Errors 
HOWEVER, if you start copying and pasting with Excel, or using the member selection feature, you must be aware of the layout rules that Essbase adheres to or you will encounter some of the following invalid layout messages:    Report mixes title row with multiple members from a single dimension 

 Member [member name] is out of place 
 Currently, multiple reports per retrieval is not supported 
 Data item found before member 

 
2.5.2 Layout Rules 
When retrieving data into an Excel worksheet from Essbase, the Essbase query engine figures out where to put the data (numbers) by scanning the spreadsheet for the labels.   Essbase scans the spreadsheet left to right and top to bottom.  As it scans, it keeps track of the member (or dimension) names it encounters, until it has found at least 1 member from each dimension in the REQUISITE layout, then it can lay in the data.     Page-oriented members: 

Row oriented members display 
data in the ROWs 

Column oriented members 
display data in the COLUMNs Page or Header oriented 

members represent ALL data in 
the worksheet e.g. ALL numeric 
data on this sheet is “FY 2013” 



   

Page 28 of 73   

Excel Smart View User Guide 

o MUST appear before column or Row oriented members. This is simple, Page oriented members are at the top of the “page” of the workbook. 
o Can only have a single dimension or member from a dimension represented. If there are 2 or more, they have to be Column or Row oriented.  
o Can only occupy a single Excel Cell 
o Are representative of ALL data on the workbook. For example, if the member “ACTUAL” from the SCENARIO dimension is in a page-oriented position, ALL of the data on the worksheet is ACTUAL data. 

   Column-oriented members: 
o MUST appear below Page members 
o MUST appear to the right of and above ROW Oriented members. 

 Multiple-dimensions can be represented, but each can only have members in a unique (excel) row. (e.g. if PERIODS dimension is Column oriented, PERIODS members might be in row 3): 
o MUST appear below Page members 
o MUST appear to the left of and below COLUMN Oriented members. 
o Multiple-dimensions can be represented, but each can only have members in a unique (excel) column. (e.g. if ACCOUNT dimension is ROW oriented, ACCOUNT members must be in column B) 
  

2.6 Navigating with Essbase 
Essbase is very powerful, but it can also seem a little daunting when zooming, pivoting, and trying to navigate the dimensions and their hierarchies.  This next section covers the basics of Zooming, Pivoting and working with data, while preserving the Layout Rules described above.  
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2.6.1 EXERCISE: Zoom 
Using the Zoom feature allows users to zoom or drill into dimensional details.  Double-check your Zoom options are set as follows:  

IMPORTANT: 
 Essbase uses the current active Cell (The cell your cursor is on, In below screen shot, C3 is the active cell) to determine many of the navigation actions. KNOW which cell your cursor is on for Zoom, Pivot, Keep Only, Member Select, etc. …           
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  1. Using the TopLevelChanged worksheet, select the ‘External Total 
Civil’ member and click Essbase | Zoom In (or double-click with your 
mouse).     

  
2. Repeat and Zoom in on Tutor Perini Civil West 
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 After Zoom In 

 
 
 Notice the cursor (Active Cell) stays in cell A4 while ‘External Total Civil’ gets pushed to the bottom.  
3. Continue Zooming In (keep the cursor on A4) until you get to the bottom of the Civil West hierarchy  
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   NOTE: Zooming in on the SAME member 2 or more times results in duplication of data in your report…if this happens, just delete the lines you do not want using the [delete] key.    ZOOM OUT and ZOOM back in. 
1. With your cursor still in cell A4 select Essbase | Zoom Out (or double 

right-click your mouse). 
2. Keep Zooming out (with your mouse A4) until you reach the Top Level ‘External Total Civil’ 
3. ZOOM back in until you find some data lower down in the hierarchy. 
4. Select ‘Project Status’ from the Page area and Zoom In (By default, zooming in on a Page dimension results in a Pivot action. Specifically, ‘Project Status’ will pivot to the outmost row-orientation (Column A in this case, and it will push any other Row oriented dimensions, like Entity into the next column (B).  

REMEMBER, a Page-oriented dimension can only have a single member from the dimension, zooming in will result in more than 1 member being displayed which means it has to switch from PAGE to ROW or COLUMN. It switches to ROW, since Excel has many more rows to provide detail than columns.  
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5. Select SmartView | Undo to “undo” the Zoom and Pivot. 
6. ZOOM in on Project Status again 
7. ZOOM in on Total Project Status 
8. Then ZOOM out on New (make sure cell A4 is selected). 
9. Keep Zooming out while on cell A4 until you are at the dimension name itself (Project Status).  

2.6.1.1 ZOOM GROUP Exercise 
When there is more than 1 ROW-oriented dimension, the data is ‘grouped’  1. Using the ZOOMGroup worksheet, select the External Total Civil 

member and click Essbase | Zoom In (or double-click with your mouse 
– if the double-click does NOT work, you will need to connect to Essbase by Connecting the worksheet. Refer section 2.1.1)   

Zooming in on a ‘Page’ oriented member invokes a 
‘pivot’ and reorients zoomed in members on rows 
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2. Notice how External Total Civil Expands. 
3. Experiment by ZOOMING IN on the Tutor Perini Civil West member in column A 

 

  
2.6.1.2 ZOOM Column Exercise 
So far we have only ZOOMED on ROW oriented members. Zooming on columns is similar, but the members expand outwards to the right instead of downwards.  1. Using the ZOOMColumn worksheet, select the Tutor Perini Civil 

East member and click Essbase | Zoom In (or double-click with your 
mouse – if the double-click does NOT work, you will need to connect to Essbase first. Refer section 2.1.1).   

2. Experiment by ZOOMING IN (double left click) 
3. Experiment by ZOOMING OUT (double right click) 

 

‘Groups’ of Account 
members grouped by Entity 
dimension 
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2.6.1.3 ZOOM Options Exercise 
In this section we take a look at the Member Options tab.  Include Selection Option  1. Using the ZOOMOptions worksheet, select the Tutor Perini Civil 

East member and click Smartview | Options   
 

Remember: The ‘Zoom In’ action on 
column dimension takes the context from 
the active cell (B3 in screen shot) to G2 
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  2. Uncheck the Include Selection option 
3. Click [OK] 
4. Zoom in on Tutor Perini Civil East 
5. Notice that Tutor Perini Civil East is removed after zooming in.  

 
6. Remember, ZOOM takes its context from the SELECTED member, by un-checking this box, the selection (Tutor Perini Civil East) is removed after zooming in. 

This Option is very useful when you are quickly drilling in to detail and are not concerned with upper level members. 
7. With cell A5 (01021 - TPC Civil – Metro) selected, click Essbase | 

Zoom Out  
8. Click Smartview | Options  and place a check on the Include Selection 

option and click [OK]. Zoom in on ‘Tutor Perini Civil East’ member. You will notice that ‘Tutor Perini Civil East’ member is retained in this zoom operation. 
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All Levels 
1. Using the [Member Options] worksheet, select the External Total 

Civil member and click SmartView | Options   
2. Check the Include Selection option 
3. Under ‘General’ section above, for Zoom In Level, select  the All Levels 

option 

 
4. Click [OK] 
5. Click Essbase | Zoom In  to zoom in on External Total Civil Member 
6. The ZOOM Action expands ALL levels below External Total Civil including the bottom, entity level members.  
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7. Select Smart View| Undo , or Zoom Out repeatedly until you reach 

External Total Civil. 
WARNING: Zooming to All Levels can make your spreadsheet expand 
very quickly with data. This feature is typically turned on for a specific Zoom action and then turned off again. 
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Bottom Level 
1. Using the [Member Options 2] worksheet, select the External Total 

Civil member and click Smart View | Options   
2. Check the Bottom Level option 

 
3. Click [OK] 
4. Zoom in on External Total Civil 
5. The ZOOM Action goes right to the bottom level External Total Civil members.  

 
 

6. Select  Smart View| Undo, or Zoom Out until the report is back to 
where you started (External Total Civil) 

 
BE SURE TO RE-SET the ZOOM Option back to Next Level!  
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The other Zoom-In and Member Retention Options are explained in the Essbase OPTIONS section of this training manual. 
2.6.2 EXERCISE: Pivot  
Pivoting data with the Pivot feature quickly reorients column-oriented data to row-oriented data and vice versa. Pivoting is incredibly useful for quickly (speed-of=thought) changing report perspectives. 

 
Some Rules: 
Using the [Essbase|Pivot] menu  

 

TIP: 
 The key to working with the pivot option is anticipating what the pivot action will do. Knowing what the report is about to look like (in other words, how the report layout: Row/Column/Page will change) before pivoting is the KEY to speed-of-thought ad-hoc analysis. 
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 Pivoting a COLUMN to a ROW, will ALWAYS result in the column member(s) switching to Column the outermost column (usually Column A). 
 Pivoting a ROW to a COLUMN will ALWAYS result in the row member(s) switching to the outermost row (this will often be row 2). 
 Pivoting a PAGE/Header, will ALWAYS result in a pivot to ROW-oriented data. The page member will switch to Column A – this is the outermost column. 

 
1. Using the [PIVOT1] worksheet, select any of the Period members  

and click Essbase | Pivot.   
2. This will move the Period members to row 2, the Period dimension members are now COLUMN oriented. 

 

  
3. Select any of the Period members and click Essbase | Pivot. This 

takes you back to the original layout. 
 
 
 Experiment with the different ROW and COLUMN members by pivoting back and forth.  
2.6.2.1 EXERCISE: Pivot multiple Row/Column 
When there are 2 or more dimensions represented in the rows or columns, it sometimes requires multiple pivots to arrive at the desired layout.  
 
Take a look at the following screenshots from the [PIVOT2] worksheet. Notice the following dimensional (report) layout: 

 Row Oriented data: [Entity members in column A], [Account members in Column B] 
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 Column Oriented data: [Year members in Row 2], [Period members in Row 3] 
BEFORE: 

 
 

 Select any of the Period members (row 3) and select Essbase | Pivot. 
This will bring the members to Column A (Now Time DATA are Row oriented). 
 

 
 

 Select any of the Periods dimension members in Column A and select 
Essbase | Pivot. This will bring the Periods dimension members above 
the Year dimension members, presenting a very different layout of the report. 

 
AFTER 1 
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 Select any of the Accounts members in Column B and select Essbase 
| Pivot. This will bring the Accounts members to Row 2.  

 
 

 Select any of the Accounts members in Row 2 and select Essbase | 
Pivot. This will bring the Accounts members into Column A.  

 
AFTER 2 

 
 
Experiment with the Pivot feature…the key is knowing the PIVOT will ALWAYS move a dimension FROM a Column orientation to the OUTERMOST Row orientation and vice versa. 
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2.6.3 EXERCISE: Keep Only 
As you continue expanding a report by drilling and zooming, you may want to eliminate some of the members. In fact, it's a good idea to continuously evaluate if members can be deleted from a report to keep it simple.    Although the (Excel) option to delete members is always available with the [delete] key, Essbase provides some additional functionality.  Keep Only To keep only certain members in a report, do the following: 

 Select one or more members (use ctrl+click or shift+click for multiple selections) 
 Select Essbase | Keep Only from the menu. 
 This will do a retrieve and restrict the report based on the members that were selected. 
 Using the [KeepOnly] worksheet, select some of the ‘Tutor Perini Civil West’ and ‘Tutor Perini Civil East’ members in column A. 
  Select Essbase | Keep Only from the menu. 

 BEFORE:   

  AFTER: 
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In some cases, it may be just as easy to use just delete members, but any time there are multiple Row oriented members, or multiple Column oriented 
members, using Keep Only and Remove Only are much more efficient. 
  Remove Only Remove only is the opposite of Keep Only.  To remove certain members in a report, do the following:   Select the member(s) to be removed from a report 

 Select Essbase | Remove Only from the menu. 
 This will do a refresh and delete the members that were selected. 
  

2.7 SmartView|Options 
This section covers the SmartView Option tabs in detail. Although it has been covered for select items in the sections above, this is where you will find full explanations of these options.  The SmartView options give you control over how Essbase works with Excel.   The first few tabs (Member Option, Data Option, and Formatting) are sheet-specific settings. That means, anything that is set or changed on any of those tabs (e.g. INDENTATION: Totals), is saved with that spreadsheet.   

  

TIP: 
 Clicking on [Help] on any of the tabs provides quick summaries of the option settings.   
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2.7.1 Member Options 
Think of the Member options as the main control for the report look and feel. The main categories for what can be controlled are:  

 Zoom Levels and placement of ancestor when zooming in 
 How to display members with aliases or as their original names 
 How to indent members 

Although these offer a large degree of control on the formatting and behavior of a report, they can be supplemented with the Excel formatting capabilities. 

 
 
2.7.1.1 Zoom Options 
Some of these options have been covered in the ZOOM exercises section earlier. 
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The following is a summary of the Zoom options 
Next Level – this is the default that drills down from a parent to its children. 
All Levels – drilling on a member will result in all the descendants of that member being displayed. Be careful here: drilling on large dimensions from the top may create a very large report.  
If the dimension being drilled on is a column dimension, the number of columns available in Excel (256) may be exceeded. 
Bottom Level – this option drills down to level zero (the bottom of the hierarchy) of the member being drilled on.   
(The following are rarely used) 
Sibling Level– drilling on a member with this option set will retrieve all of its siblings. 
Same Level/Same Generation– drilling on a member will return all the members that are at the same level or generation as the member you zoomed in on. 
Formulas–returns any members that may be a part of the formula for the member being drilled on. If the member being drilled on has no formula, nothing will happen. 
2.7.1.2 Member Name Display 
Member Name Only– Displays the member name and not the alias.  
Member Names and Alias– this option will show both the member name and its alias for the row dimensions in the report.  It does not affect the column and 
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page dimensions. After setting this option a refresh has to be performed so that the worksheet is refreshed and aliases are displayed. 
2.7.1.3 Indentation 
Indentation: None, Sub-items, Totals– these options control how members are displayed in the ROWS.   

 None will make all members regardless of their position in the hierarchy have no indentation.  
 Sub items will indent each level of the dimension more as the hierarchy is zoomed into.   
 Total’s is the opposite of Sub items. 

NONE:  

 
SUBITEMS (Bottom level members are indented most):  
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TOTALS (Upper-level members are indented most…the ‘bottom line’ is indented most):  

 
 
Member Retention: Include Selection– with this option selected the zoom in results will include the member that was zoomed in on. If this option is de-selected, the member that is zoomed in on will be deleted after the drill in. 
Member Retention: Within Selected Group– this operation affects the drill behavior of both row and column dimensions.  When this option is disabled, Essbase operations will always behave symmetrically so that the same operation is applied to all row or column groupings.  For example, if you are drilling on Margin for all quarters, a drill with this option deselected will drill on all quarters. 
Comments and Formulae– Of all the Member Options tabs, the name of this one is the least intuitive in terms of defining what they are used for.  These 
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modes affect the behavior of SmartView. This will preserve any excel formulas and comments put in the by the user on the worksheet. Please note that comments should not be same as an Essbase member otherwise Essbase displays an error. 
Switching between the different modes contained in this tab will restrict the use of other options. For example, the Formula Preservation option which keeps formulas from being overwritten cannot be used in with the Suppress Missing Display option, and pivoting data will no longer work. 
 
 

 
 
2.7.2 Data Options 
Suppress Rows: No Data/ Missing, Zero– when suppress missing or zero is selected, any Essbase operations performed will delete rows (not columns) that are entirely empty or zero respectively.  This is a great way to limit the size and scope of a report to the relevant intersections in the report that have data. 
Suppress Columns: No Data/ Missing, Zero– when suppress missing or zero is selected, any Essbase operations performed will delete columns that are entirely empty or zero respectively.  This is a great way to limit the size and scope of a report to the relevant intersections in the report that have data. 
Suppress: Underscore Characters– this option will delete any underscore characters in member names - this is a near obsolete option. 
Replacement: Missing Label, No Access Label– when Essbase encounters a null or an intersection of data without data the default text that is displayed is #missing. Similarly, when Essbase encounters a data intersection that a user doesn’t have access to, the default text that is displayed is #NoAccess.  In these options, the text that is displayed can be changed to whatever you like.   
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Common choices for missing are  
 ‘0’  
  ‘—‘. 
 “ “ (blank space) 
 ‘(0)’ 

 
Mode: Navigate without Data – This option can be useful when a user wants to create a report template first without refreshing data every time the user makes a change/pivots, zooms etc. on members. Checking this option prevents data being refreshed every time. Once a user has set his report template, this can be turned off and a refresh done to retrieve data once. 
!!! Make sure you remember you have turned this on so that you can turn this off once the report template has been finalized. 
Mode: Suppress Missing Blocks – This option is available only for block storage applications and is used to suppress rows/columns for blocks that have all of the cells set to #missing.  
Formatting: 
Adjust Column Width– this option will adjust the cell widths in the entire report so that member names or their aliases are fully displayed without being cut off. 
  
2.7.3 Cell Styles Options 
Cell Styles have already been reviewed near the beginning of this document. To reiterate, for most ad-hoc types of analysis setting the Parent style to bold is sufficient. Nonetheless, some users experiment with the other style options which are summarized here. 
Cell Styles options control the member and data fonts that are displayed in a report.  They come under three main categories:  

 Member styles which are applied depending on the types of members. 
 Dimension styles which affect an entire dimension’s member name formatting. 
 Cell options which change the formats of individual data cells in the reports. 

Once styles are enabled the font can be formatted by type, size, color, and other format characteristics.   
Remember, as with the other Essbase options, you will have to perform some sort of Essbase operation such as a retrieve, in order to see the Analytic Services you have selected applied. 
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To activate Styles, you have to check the Use Styles checkbox in the Cell Styles Options. 
 
 



   

Page 53 of 73   

Excel Smart View User Guide 

 
Here is a summary of what the styles do: 
Member Cells: Attribute– applies to all members of the base dimension which have attributes associated with them. 
Member Cells: Dynamic Calculation– applies to all members which have dynamic calculations in the outline 
Member Cells: Contains Formula– applies to all members which have formulas in the outline. 
Member Cells: Shared– applies to all members that are shared members – they occur more than one time in a dimension. 
Member Cells: Child– applies to all members which are children in the outline. 
Member Cells: Parent– the style applies to all members that are parents in the outline.  This can be a great way to help navigate an outline because it will indicate when you have reached the lowest level in the hierarchy (those members will not have styles applied to them). 
Member Cells: Duplicate Member – applies to all members which have duplicate member in outline 
Member Cells: Member Drill-through – Highlights if drill through can be performed on the member 
Dimensions– when these styles are enabled you will see all the dimensions in 
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your database displayed. You can apply certain member formatting to an entire dimension.  This is not commonly used. 
Data Cells: Linked Objects, Read, Write–these styles affect the formats of data cells in a report. If a report has a Linked Objects associated with it, you can show a style to better display its existence.  You can also see what your security access is to the data by enabling the read/write styles. 
 

Tip:  Be aware that whenever you set Style options in the Smart view, they will override your Excel formatting.  For example, if you have a bold/italic style set on a member through Excel, and you set a dimension style on that member’s dimension, a subsequent retrieve will overwrite your Excel styles.   
 
2.8 Member Selection 
The Member Selection feature is very helpful. One of the best things about the Member Selection tool is that users can browse the dimensional hierarchies.  This tool is great for hand-picking members or sets of members for your report.  Use the [MemberSelection] worksheet):  
Click on the External Total Civil member. 
From the menu bar select Essbase | Member Selection.  
 

  Expand the Entity structure and select (put a check on) the entities you want to report on.   Then click on the Add button and then click OK.  Make a note of two options on the left side of the OK button. These options allow you to put the selected members horizontally or vertically on your spreadsheet. Default is Vertical. You should select horizontal for member 
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selection on column oriented members. You should select vertical for member selection on row oriented members.  

  You will notice that the selected entities are put on the report. Now do a refresh off the worksheet to see the data for these entities.  Before Refresh 
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After Refresh 

  The Dimension drop-down box takes its context from the selected excel cell. 
o CAREFUL…No Flashback, and Essbase will “Paste” the Selected Members wherever the active cell is. ALSO, Active cell dictates WHICH dimension shows up in drop down.  
o Only place to systematically add attribute dimension members 

 
The member selection tool allows you to choose a member or members from the hierarchy and then paste the selection into the report.  For example, you might have forgotten the name/number of a certain entity.  By doing a member selection on the entity dimension, you can navigate the entity hierarchy and pick the entity from the entity dimension. 
The member selection rule can be used to pick members based on certain criteria such as what level or generation they belong to, their relationship to other members (children, descendants), and other selection rules. 
2.8.1 Mechanics 
 
To perform a member selection, do the following: 

1) Select a Cell.  Select the cell location where you will want to paste members into the spreadsheet.  Most of the time, you can select a member from the dimension you want to select from.   
Select the Essbase->Member Selection menu option. 
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2) Select the Dimension.  From the drop down box, select the dimension you want to paste from. The default will be the dimension from the member you had selected before entering the Member Selection tool. If you did not select any member, the default will be the first dimension in the outline. 
3) Select the View Method.  You can select members based on their names and relationships to one another, as generation and as levels etc., You can move between view methods and select based off multiple methods.   
4) Select the Members.  Depending on the view method, add the member selections to the rules. 
5) Further Define the Selections.  Depending on the selection in the Rules, if you right click on a selected member, you can further define the selection (more on this later). 
6) Select the Output Options.  The output options help control the behavior of your selections.  Select these options. 
7) Preview/Save/Run.  You can preview your selection at any time to get a list of all the members that will be pasted into the sheet.  You can also save the member selection – this may be desirable if it is a complicated member selection rule that you will be frequently using. Run the member selection by clicking OK. 
8) Retrieve the Report.  The member selection tool is really just a sophisticated copy and paste tool.  You still need to retrieve your report to pull the data associated with the members, which were selected. Essbase will not update the data automatically. 
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2.8.2 Selecting using Relationships 
The most basic way of defining a selection is to pick multiple members from the outline by clicking on individual members or by doing a multiple select (control-select or shift-select) and adding a group of members at one time.  
After you select members, who were chosen using the member view options, you get the following options when you right click on the selection rules: 
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 Level Name – This will allow you to select any level for the member selected.  The level is chosen with the member as a point of reference and will only select levels beneath or above that member. As an example, selecting level zero of a product department will result in the selection of all SKU’s that fall under that department. 
 Generation Name – This will allow you to select any generation for the member selected.  The generation is chosen with the member as a point of reference and will only select generations beneath or above that member.  
 User Defined Attribute-as discussed in the first Section, any member can have User Defined Attributes associated with it that help further describe it. For example, you can select all the Level 0 products that have a UDA of blue, i.e. all blue products. 
 Pattern-with patterns you can select members based on names. You can search for all members based on character (?) or trailing wild card (*) searches.  Here’s some examples: 

D*  - will find all members that start with the letter D. 
?ing    - this is a character wildcard search so that all members ending in “ing” with any other first letter initiating the word will be selected – e.g. Bing, sing. 
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2.8.3 Coordinating Member Select with Report Rules 
The end result of any member selection regardless of how simple or sophisticated it is will be that it will paste members into the sheet.  It will always begin pasting on the cell that had focus before you entered the Member Selection tool.  With this in mind, it is common for users to perform member selections into a report and inadvertently cause the report to generate errors on subsequent retrieves.  Essbase will still enforce the rules for how a report should be laid out. Consider these points to stay out of trouble. 
 Page selections - if the member selection is on a Page/Header dimension, select only one member.  If you want more than one member for that dimension, consider changing the report so that dimension is a row or column before doing the member selection. 
 Column Dimensions - if you are selecting into a column dimension and you have multiple members, make sure to uncheck the Place Down the Sheet Output Option in the Member Selection Dialog Box. This will paste the members across your report instead of down the report. Also, it is best to column select into a report that only has one column dimension – otherwise the column groupings may become misaligned with your selection. If you have multiple column dimensions, consider simplifying your report first so that only one member is displayed for the other column dimension. 
 Row Dimensions - if you are selecting into a row dimension and you have multiple members, it is best to select into a report that only has one row dimension – otherwise the row groupings may become misaligned with your selection. If you have multiple row dimensions, consider simplifying your report first so that only one member is displayed for the other row dimension(s), which are not being selected on. 
2.9 Reporting on Attribute dimensions 
 
Attribute dimensions are tagged to a base dimension to aid in filtering and reporting data based on the attributes tagged to a base dimension. In the Projects application, 9 attribute dimensions have been tagged to the base Projects dimension. What this means is you can do a report based on any of these attributes. Please note that attributes work in relation with the base dimension they are associated with.  You must supply an attribute value to tell Essbase that this is the attribute you want to filter projects on.  
Dimensions Dimension Type Description 
Projects Base Contains the project codes  
State Attribute Attribute dimension to report project related data based on the location defined by the 
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State, e.g. CA, AL,AZ 
End Market Attribute Attribute dimension to report project related data based on the project’s end market e.g. AIR, BRI 
Contract Type Attribute Attribute dimension to report project related data based on the project’s contract type e.g. CP (Cost Plus), FP (Fixed Price) 
Client Source Attribute Attribute dimension to report project related data based on the project’s client source e.g. FE (Federal), PV (Private) 
Job Stage Attribute Attribute dimension to report project related data based on the project’s job stage e.g. CLD (Closed), OPN (Open) 
ICP Attribute Attribute dimension to report project related data based on the project’s intercompany tagging e.g ICP-Y (Intercompany project), ICP-N (Not an intercompany project) 
Job Type Attribute Attribute dimension to report project related data based on the project’s job type e.g. JA (Job Cost Administrative), JB (Job Cost) 
Ownership Type Attribute Attribute dimension to report project related data based on the project’s ownership type e.g. JVN (Joint Venture Non-Sponsored), WO (Wholly Owned) 
Insurance Type Attribute Attribute dimension to report project related data based on the project’s insurance type e.g. CAL, SEL 
 
Attribute dimensions can be selected using the member selection option. 
Select Essbase | Member Selection and then click on the Dimension Drop 
down list. You will see all the dimensions in the application including the attribute dimension. 
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Use the [AttributeReporting] worksheet):  
In this exercise, we will report on all projects for ‘External Total Civil’ that has the end market as BRI. 
Click on the Projects member and insert a column to its left. Next, click on cell 
A4 and then from the menu bar select Essbase | Member Selection.  
From the dimension drop down list, select End Market 
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The End Market dimension and its members are displayed. 

 
Put a check on BRI-Bridges and add it to the right using the Add button and 
then click ok. Click Essbase | Refresh to the refresh the worksheet. You will see 
the numbers change as Essbase is now only fetching the data for projects that have BRI end market attribute tagged to it 

 
From the Smart view options, ensure that Suppress Missing has been selected. 
Select Projects member and then click Essbase | ZoomIn -> Bottom Level 
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After Zoom-In 

 
 
Use the [AttributeReporting2] worksheet):  
Use the previous exercise and retrieve/filter projects based on Contract Type as CP – Cost Plus and Client Source as FE- Federal 
Hint – You would need to insert two columns to the left of Projects member and then use member selection to select the two attributes. 
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Once you are at the above layout. Zoom-In on Projects bottom level members 
2.10 Knowing what attributes are tagged to Projects 
 
In the previous exercise, you supplied Essbase with an attribute value and then viewed data based on those attributes. You also then zoomed-in on bottom level projects to see the projects.  However, what if you did not know the specific attributes that have been tagged to an individual project? Attributes cannot supply this information (it must be provided by the user).  To work around this, text measures have been added to the application which allows you to see what attributes have been tagged to projects.  Exercise 
Use the [AttributeInfo] worksheet) 
Note the POV members: the attribute info will always be available at the combination of Entity N/A, Year N/A, Project Status N/A, JDE Actual and Periodic. This has been setup this way so a user does not have to remember specific Year, Period, Entity etc. intersections.   
From the Smart view options, ensure that Suppress Missing has been selected.  
Select Projects member and then click Essbase | ZoomIn -> Bottom Level 
The worksheet refreshes and shows the attribute information for each project. See the [AttributeInfoResult] worksheet to see the result of this operation 
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3 Top Five (+1) SmartView Actions 
 Even though there are dozens of features that can be used, most ad-hoc analysis can be accomplished with the following TOP-5 + 1 commands. Mastering the five following actions will enable you to build Essbase reports in using Smartview rapidly.   1. Zoom In – use this feature to quickly drill to detail members from dimensions. Switch between Next, All, and Bottom levels for more control. 

a. Next Level – This is the most common setting, and should be set to this level most of the time to avoid initiating zooms that expand to hundreds or thousands of rows. 
b. All Levels – turn this on/off very selectively, this is useful when you want to examine the full hierarchy of members (use with SUPPRESS MISSING). 
c. Bottom Level – turn this on/off selectively. This is useful when you want to isolate the bottom or level 0 members of a dimension or hierarchy. 

 2. Keep Only / Remove Only – As you are drilling in to a dimension, isolate the members or subsets of members with either of these commands.  
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3. Pivot – Use pivot to quickly reorient members from the rows to columns and Columns to Rows.  4. Member Selection – To pick specific members or sets of members from the outline, use the Member Selection option:  5. Suppress #MISSING  – Use Suppress Missing to isolate rows of members that actually have data in them:    +1 – PLUS One). – Manually typing in member names – This is not really an Essbase option.   The idea is that once you are familiar with the Essbase database(s) where most retrievals take place, you can also type in the member names. For example, if you want to get right to a specific Cost Center, department or account, and you know what the member name is, just type it in, manually.  The only thing to be aware of are typos.  Note: When typing in a member that is numbers only (i.e Entity 01001 or Project 17500000), the member must be preceded by ‘ so that Essbase knows the number is not a data entry:   ‘01001 instead of 01001  ‘17500000 instead of 17500000  
4 SmartView Common Errors and Issues 
The following is a list of common error messages or questions users have when first getting familiar with SmartView  
4.1 Adhoc grid cannot be opened as there are no valid rows of data 
 

  Problem: Users get above message when they attempt ad-hoc analysis on a Planning database (using a Planning connection in SmartView). This is due to Smartview settings set to suppress missing and zero values.   Solution: Change smart view settings to not suppress missing and zero data on rows and columns. To do this, go to SmartView->Options->Data Options. 
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Uncheck the suppression options for Rows, Columns and Blocks and then perform ad-hoc analysis  

 
4.2 Essbase Error (1020010): No data was generated 
  

  Problem: Users get above message when they attempt ad-hoc analysis on an Essbase database (using an Essbase connection in SmartView). This is due to Smartview settings set to suppress missing and zero values.   Solution: Change smart view settings to not suppress missing and zero data on rows and columns. To do this, go to SmartView->Options->Data Options. Uncheck the suppression options for Rows, Columns and Blocks and then perform ad-hoc analysis  
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4.3 Timeout Errors 
 Problem: If the server takes longer to process a Smart View operation than the timeout value set on the client computer, users may receive a connection timeout error, or zero values may be displayed for Smart View functions.  

  Solution: Increase the timeout limit for Smart View client computers. Smart View uses Win-Inet APIs to communicate with the provider. These are the same modules that Internet Explorer uses. To increase the timeout value for a Windows client computer, contact Adnan Aslam. He will have access to a patch that increases the timeout settings. 
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4.4 SmartView Tab not visible in MS Excel 
 Problem: The smart view tab is not visible in MS Excel. This could be due to a. MS Excel crashed and disabled SmartView or b. Multiple instances of MS Excel are open   Solution (a):  This indicates that Smart View may have become disabled in MS Office. To enable SmartView, open MS Excel. Go to File->Options  

     Then Click on Add-Ins. Then from the ‘Manage’ selection, select ‘Disabled Items’ and hit ‘Go’. If Smartview has been disabled, it will show on the list. Select Smartview and click ‘Enable’ and then ‘Ok’. Exit MS Excel and re launch MS Excel.  
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  Solution (b): Exit MS Excel and open task manager. On the process tab, sort on the process by clicking on ‘Image Name’ to sort the processes. Locate ‘EXCEL.EXE *32’ and click on ‘End Process’  
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Next, launch MS Excel, go to Go to File->Options  
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Then Click on Add-Ins. Then from the ‘Manage’ selection, select ‘Excel Add-Ins’ and hit ‘Go’.   

   
Ensure that the ‘Oracle Smart View for Office’ has been checked. If not, put a check next to it, and then click ‘OK’. Exit MS Excel and re launch MS Excel, the SmartView tab should be visible now.  

  


